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Chapter�· "A Quick Loo� at Picture Manager" will give you an 
opportunity to see how Picture Manager works by taking you 
through e�ch ?f the functions of the program. Using one of your 
own MultrScribe documents and a picture file we've included on 
your installation disk, you'll see how quick and easy it is to add a 
"creative touch" to your documents. 

iii About this Manual 

This manual is divided into four chapters: the first chapter gets you 
started. the next two explain how to use Picture Manager, and the 
fourth chapter serves as a quick reference. 

Chapter I, "Getting Started" is a helpful "checklist" of items you'll 
need before you can begin using Picture Manager. This includes 
things you'll already know from using MultiScribe, as well as a 
review of basic keyboarding and mouse procedures. If you're 
completely familiar with MultiScribe, just a quick review of this 
chapter (in particular the "Installing Picture Manager" section) will 
be necessary. 

· Chapter 3, "Using Picture Manager," provides detailed 

I 
instructions for using your new document processing tool. This 
chapter tel�s Y?U how to perform specific tasks such as "Getting 
from MultrScribe to Picture Manager," "Resizing the Picture 
Frame," and "Getting Back to MultiScribe." 

Chapter 4, "Quick Reference," provides a summary of all the 
�enus, commands, and dia_Jog boxes yo_u'll encounter while using 
Picture Manager, plus detailed explanations for other technical 
matters not �)ready covered in the previous chapters. This chapter 
conclu�es with a Glossary of MultiScribe/Picture Manager terms. 
Use this reference chapter when you need a quick, detailed 
description of a particular command or an explanation of a word 
you don't understand. 

About This 
Manual 
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• MultiScribe Commands 
Because Picture Manager works as an online accessory to 
MultiScribe and uses some of the same basic operating 
principles as MultiScribe, you should already know how to use 
MultiScribe, as this will give you a greater understanding of 
how Picture Manager works. If you haven't used MultiScribe 
before, practice creating at least one text decument file so that 
you'll understand the similiarities between the two programs. 

• ProDOS Utilities 
First, you should be familiar with the ProDOS operating 
system. By knowing how ProDos works and the basics of the 
useful utility programs on the Apple Systems Utilities Disk, 
you'll have a greater understanding of MultiScribe and its 
accessory applications such as Picture Manager. 

• dot matrix printer (optional) 

• mouse ( optional) 

• a compatible graphics program 

• Mouse Techniques 
Because Picture Manager can be used with or without a mouse, 
instructions for both are provided in this manual. If you're 
planning to use a mouse with Picture Manager, a thorough 
familiarity with the various mouse techniques will be useful, 
particularly when creating graphics files. 

Picture Manager comes on one single-sided disk. To use Picture 
Manager, you'll need: 

j • an Apple Ile computer 

I OR 

• an Apple Ile computer with an extended 80-column card 

• a backup copy of MultiScribe version 2.0 

• blank diskettes 

What You Need to 
Get Started 

What To Know 
Before Starting 

2 Chapter 1: Getting Started 3 What to Know Before Starting 
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The last section will give you step-by-step instructions for 
installing Picture Manager for use with MultiScribe. 

The next two sections discuss the materials that you'll need to 
have and what you should already know before you begin. If you 
require more detailed information about a particular program or 
function, you'll probably want to review the recommended 
reference materials before installing Picture Manager. 

This chapter will give you an overview of what Picture Manager 
can do and what you'll need to get started. The first section 
briefly explains the Picture Manager program and how it is 
intended to be used. 

Introduction 



• Choose Install Accessories from the o Menu. 

OK I Press <RETURN> I Cincel I Press <ESC> 

InstlD ltteSsories 
I PATH: tlllLnSCRIBEt 

You must have version 2.0 (or greater) of MultiScribe to run 
Picture Manager. 

II FBI Edit hard Forat FNt Sin Style 

PICTURE IIAHAGER . 
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Install 
+ <SPACD ------ 

The Install Accessories dialog box appears. For more 
information on using the Install Accessories command, see the 
MultiScribe manual for MultiScribe 2.0 (or the 2.0 Addendum 
if you purchased an update to version 2.0). 

"Picture.Manager" appears in the list of available accessories 
on the specified path, on the left hand side of the dialog box. 

5 Reference Materials 

• Start up MultiScribe. 

• Click the Drive 1 button or press 01. 

ii! 

�i 
�i 
ii! 11 

I J! I 

i! I 
J! � 
f! � 
�!� �' ii I 

4 Chapter 1: Getting Started 

The first choice for installing Picture Manager is on the second 
side of your MultiScribe disk. An unaltered MultiScribe disk will 
have enough room on it for the Picture Manager accessory 
program file. 

• Using your file utilities program, move the file 
"Picture.Manager" to side two of your 
MultiScribe disk. · 

To install Picture Manager, you'll need your Apple II System 
Utilities disk (or a similar file utilities program, such as Copy 
II Plus) and the Apple ProDOS User's Manual, so have 
them handy before you get started. 

The Apple ProDOS User's Manual and the Apple II 
System Utilities Disk, both included with your Apple 
computer when you originally purchased it, will provide a general 
overview of the ProDOS operating environment. 

For specific details on operating MultiScribe, a quick review of 
either the MultiScribe User's Manual with the Version 2.0 
Addendum OR the MultiScribe 2.0 User's Manual will 
provide the necessary information. 

Of course, each individual graphics program will have its ow� 
user's manual with specific instructions and commands about its 
operation. 

If it's been a while since you've used some of the materials listed 
above, the user's manuals will serve as quick refreshers. 

' • How to Create Drawings 
This is where your creativity is the key. Because each graphics 
program is different, refer to your particular program's user 
manual for specific instructions. You may find it helpful to 
create a "portfolio" of commonly used graphic drawings and 
pictures to use as you create your text files. 

... With a Single 
5.25-inch Drive 
System 

Installing Picture 
Manager ... 

Reference 
Materials 



7 Installing Picture Manager. 

The Install Accessories dialog box appears. For more 
information on using the Install Accessories command, see the 
MultiScribe manual for MultiScribe 2.0 (or the 2.0 addendum). · 

Install Accessories 

I PATH• IPIC.IIGRI 

El File Edit Smch For1at Font Size Style 

OK I Press (RETURN) I Cancel I Press <ESC> 

ua::ill:lll:llllllllllllolalll- t ! Drive I I 61 
HIHfl62 
! Pith I 6P 
I List Yol. I 6¥ 

I Install I 
+ (SPACE) .._ ....... 

• Using MultiScribe in drive one, insert your 
Picture Manager disk - or a disk containing 
Picture Manager- in drive two. 

• Choose Install Accessories from the O Menu. 

When using MultiScribe and Picture Manager with two drives, 
you have the option of putting Picture Manager on side two of 
your MultiScribe disk and using the disk in drive two as your data 
disk (forpictures and word processing files), or you can keep a 
disk containing Picture Manager in drive two and install it from 
drive two. If you choose the former procedure, use the 
instructions for installing Picture Manager with a single drive 
(above); if you choose the latter, use the following instructions. 

i 
I 
I 
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... With Multiple 
5.25-inch Drives 
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I PATH= JIIJLTISCRIBEI 

"Picture.Manager" moves to the list of installed accessories, on 
the right hand side of the dialog box - indicating that it's 
installed. 

El File Edit Smch Fornt Font Size Style 

You won't have to scroll the list unless you've put accessories 
other than Picture Manager on the disk. · 

OK I Press (RETURN> I Cancel I Press (ESC) 

Install Accessories 

MultiScribe saves the accessory installation information on disk 
and returns to the MultiScribe document window. If you have 
less than six accessory applications or desk accessories (not . 
including the FontEditor) installed, the title "Picture.Manager" 
appears on the - Menu; if you have six installed, you'll have 
to choose Run Accessories from the · Menu to run Picture 
Manager. 

6 Chapter 1: Getting Started 

• Select the Picture Manager accessory file by 
clicking on its name ("Picture.Manager") in the 
list or by scrolling the list until its filename is 
highlighted. 

• Click the OK button or press Return. 

• Click the Install button or press the space bar. 



• Click the OK button or press Return. 

PICTURE.IIAHAGER 

The Apple ProDOS User's Manual gives complete details 
on the procedure for both formatting disks and creating new 
subdirectories. 

• Using the Apple System Utilities Disk (or a 
similar file utilities program), format a disk on 
which to create a subdirectory where you can 
install Picture Manager. 

• After formatting the disk, create a subdirectory 
and name it "/ACCESSORIES." 

The Install Accessories dialog box appears. 
9 Installing Picture Manager. 

• Start up MultiScribe. 

• Choose Install Accessories from the o Menu. 

MultrScribe saves the accessory installation information on disk 
and returns to the MultiScribe document window. If you have 
less than six accessory applications or desk accessories (not 
including the FontEditor) installed, the title "Picture.Manager" 
appears on the : Menu; if you have six installed, you'll have 
to choose Run Accessories from the : Menu to run Picture 
Manager. Whenever you run Picture Manager, you'll want to 
be certain that you have the disk from which you installed the 
program in drive two. 

You may be using a 5.25-inch disk drive and find that you don't 
have enough room for Picture Manager, or any other accessory, 
on your MultiScribe disk. If a second disk is required to hold 

. your accessory programs, you'll want to create a special disk to 
I_ hold your data files and accessory files. The most convenient way 
11 to use MultiScribe on a single drive system with Picture Manager 

on a different disk is to have all your accessory files on the same 
J disk as your data files. If you have a dual-drive system, you can 

have access to both programs at the same time. If your system 
consists of a single drive, this configuration will allow 
simultaneous access to both Picture Manager and your data files. 

I 

I 
I 
I 

. 

I 

I 

.•• With Two Disks on 
a Single 5.25-inch 
Drive System 
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Instill Accessories 

II File Edit Search Forut Font Size Style 

"Picture.Manager" appears in the list of available accessories 
on the specified path, on the left hand side of the dialog box. 
The pathname "/Pie.Mgr/" appears in the Pathname input bar. 

0( I Press {RETURN> I CJncel I Press <ESC> 

I PATH: IPIC.11:Rt 

"Picture.Manager" moves to the list of installed accessories, on 
the right hand side of the dialog box - indicating that it's 
installed. 

You won't have to scroll the list unless you've put accessories 
other than Picture Manager on the disk. 

• Click the Drive 2 button or press 02. 

8 Chapter I: Getting Started 

• Select the Picture Manager accessory file by 
clicking on its name ("Picture.Manager") in the 
list or by scrolling the list until its filename is 
highlighted. 

• Click the Install button or press the space bar. 
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Install Accessories 

Space shouldn't be a problem on a 3.5-inch disk. In fact, if 
you're using MultiScribe and Picture Manager on a 3.5-inch disk 
you'll have so much space available that you'll want to organize 
your files carefully, which means you'll probably want to create a 
special subdirectory for all your accessory applications and desk 
accessories. 

MultiScribe will ask you to insert the MultiScribe disk to save 
the accessory installation information on it and then return to 
the MultiScribe document window. If you have less than six 
accessory applications or desk accessories (not including the 
FontEditor) installed, the title "Picture.Manager" appears on the 

· Menu; if you haie. six installed, you'll have to choose Run 
Accessories from the · Menu to run Picture Manager. 
Whenever you wish to run Picture Manager, you'll want to be 
certain that you have the disk from which you installed the 
program on hand. 

/HARD1/MULTISCRIBE/ACCESSORIES 

("Hardi" is an example name for the root volume of your hard 
disk; your particular hard disk may have a different name.) 

• Using the Apple II System Utilities Disk, copy 
Picture Manager from the master disk to the 
disk on which you just created the 
subdirectory. 

If you create the subdirectory on a hard disk, the subdirectory 
could be named: 

This task is fully described in the "Copy Files" section of the 
ProDOS User's Manual. When asked for the name of the 
file to be copied, type "Picture.Manager." 

11 Installing Picture Manager 

Using the Apple System Utilities Disk (or a similar file utilities 
program), create the subdirectory where you plan to install Picture 
Manager. The Apple ProDOS User's Manual gives complete 

I details on the procedure for creating a new subdirectory. If you 
create the subdirectory on a UniDisk 3.5 where MultiScribe is 
already installed, the subdirectory could be named: 

/MUL TISCRIBE/ACCESSORIES 

... With a UniDisk 3.5 
Drive or Hard Drive 

I Cancel l Press <ESC) OK I Press (RETURN> 

PICTURE.IIAHAGER • •Mill 61 PICTUREJIANACER 
l Drive 2 I 62 
l Path I 6P 
I List Yol. I 6Y 

� + (SPACE> ------ 

"Picture.Manager" moves to the list of installed accessories, on 
the right hand side of the dialog box - indicating that it's 
installed. 

You won't have to scroll the list unless you've put accessories 
other than Picture Manager on the disk. 

II File Edit Semh Forut Font Size Style 

! PATH: IPIC.11GRI 

The volume name for your accessories disk ("Accessories") 
appears in the Path input bar and a list of the accessories on this 
volume appears in the list on the left side of the dialog box. · 

• Click the OK button or press Return. 
10 Chapter 1: Getting Started 

• Click the Install button or press the space bar. 

• Select the Picture Manager accessory file by 
clicking on its name ("Picture.Manager") in the 
list or by scrolling the list until its filename is 
highlighted. 

• Replace the MultiScribe disk with your 
Accessories disk and click the Drive 1 button 
or press d 1 . 
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Install 
<SPACE 

PICTURE.IIAHAGER 

• Select" the Picture Manager accessory file by 
clicking on its name ("Picture.Manager") in the 
list or by scrolling the list until its filename is 
highlighted. 

• Click the Install button or press the space bar 
to install Picture Manager. 

"Picture.Manager" moves to the scroll window on the right 
side of the dialog box. 

II File Edit Search Fornt Font Size Style 

OK I Press <RETURN> l Cmel I Press <ESC} 

I PATH= /IIJL TJSCRJBEIACCESSORJES 
Instill Accessories 

The left side of the dialog box displays a list of any accessories 
on the specified path. 

• Click OK or press Return. 

Picture Manager is now installed in a subdirectory on your 
MultiScribe program disk and will appear as a selection on the 
·- menu. To check this, pull down the ·- menu. The "Picture 
Manager" command should be listed beneath FontEditor. If 
you have more than six accessories installed, you'll have to run 
Picture Manager from the Run Accessories command. For 
more detailed information about the Install Accessories and 
Run Accessories commands, refer to the MultiScribe 2.0 
manual or the Addendum to version 2.0 of MultiScribe. 

13 Installing Picture Manager. 
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Instill Accessories 

The Install Accessories dialog box appears o,n your screen. 

OK I Press <RETURN> l Cincel I Press <ESC> 

II File Edit Semh For11t Font Size Style 

After the Picture Manager program has been copied, copy the 
rest of the files provided on the same master disk, if you have 
the room. These are picture files which you can use as you 
master Picture Manager. 

12 Chapter I: Getting Started 

• Enter the pathname for the directory on which 
Picture Manager can be found. 

• After you've copied Picture Manager to your 
MultiScribe disk, start up MultiScribe 2.0. 

• Choose the Install Accessories command from 
the O menu. 
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D 
6 File Edit 

If you're using Picture Manager with two disks on a single 
drive system, you'll be asked to insert the disk containing the 
path from which you installed Picture Manager. 

After a few seconds, a clear screen with a different menu bar 
appears. 

�top at a�y point in your text document where you would like to 
msert a picture. One feature you'll probably like about Picture 
Manager is the ability to access the program from anywhere in a 
text document, without having to quit the program! 

• Choose Picture Manager from the o menu. 

If you haven't used MultiScribe in a while, or if you've never 
used it, spend some time looking over the MultiScribe User's 
Manual and familiarize yourself with the MultiScribe program 

I 
befor� proceeding with_ Pictur� Manager. Remember, you must 
use Picture Manager with version 2.0 (or later) of MultiScribe. 

Start by opening one of your own documents. To avoid any 
probl_ems_ with your text files, it's advisable to save your 
Multi'Scribe documents before using any of the accessory 
programs. 

Getting into 
Picture Manager 
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The last section, Getting Back to MultiScribe, will show you how 
to return to your MultiScribe document from Picture Manager. 
While in MultiScribe you'll see how to "paste" the picture into 
your text document. 

This chapter will do exactly what it says - give you a "quick 
look" at Picture Manager by actually taking you through the steps 
needed to use the program. 

The first section, Getting into Picture Manager, starts with a 
typical word processing situation where the addition of a 
picture/graphic is desired. Using your own word processing 
document, you will see how easy it is to access the Picture 
Manager program from MultiScribe. 

The next section, Getting Around in Picture Manager, will 
familiarize you with the four main elements of the Picture Manager 
program: the menu bar, the picture frame, the screen icon, 
and the work area. You'll work on a picture file provided with 
the Picture Manager disk, learning to frame and copy the picture 
into your text file. 

Introduction 

16 Chapter 2: A Quick Look at Picture Manager 

Welcome to Picture Manager! 

17 Getting into Picture Manager 



• the menu bar 
• the picture frame 
• the screen icon 
• the work area 

The menu bar displays the --1------+ 
titles of the menus from 
which you choose commands. 

• Choose Open Picture from the File menu. 

D llD!ll Edit 

A dialog box appears. 

As with a document text file, before working on a picture file, you 
must first "open" it (read it into the computer's memory from 
disk). You'll do this with the Open Picture command, which 
works much like the MultiScribe Open command, except that it 
opens pictures rather than document files. 

Opening a Picture 

ll File Edit 

Looking at your screen, notice that there are four main elements of 
the Picture Manager screen: Getting Around in 

Picture Manager 

Open Picture 

I Open Press <RETURN> 
+ I Cancel Press <ESC> .._ _ 

The Picture Manager disk comes with a number of pictures you 
can use to experiment with; in this chapter, you'll be using a 
picture of a horse - the same picture shown on the manual cover. 
To use this picture, you'll want to have a backup copy of your 
Picture Manager disk ready. 

t I Driwe 1 l Press lll 
1ufHfj Press {12 
I Pith Press llP 
I List Vol. Press llY 

HORSE 
DRAGON 
PAINT BLUEJAY 
SPHERES 

I PATH= IPIC.tlGRI 

The Open dialog box works just like the MultiScribe Open dialog 
box, except that only the names of picture files will appear in the 
file list. In addition to the file list, the Picture Manager Open 
dialog box contains an input bar for pathname, buttons for 
specifying path (Drive 1, Drive 2, Path, and List Vol.), and 
buttons for Open and Cancel. 
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The screen icon toggles ---+--+---------------/ 
the menu bar on and off 

The work area is where ----+---+-------- 
your picture appears: with the 
menu bar toggled off. it can 
occupy the entire screen 

The picture frame is a ----+----+----+ 

small square about 3/4" by 
3/4" that selects the portion 
of the picture to be added to 
your text document. 

18 Chapter 2: A Quick Look at Picture Manager 
19 Opening a Picture 



• If you're using a multiple drive system, put 
your Picture Manager disk in drive two and 
click on the Drive 2 button or press j2. 

• If you're using a single drive system, replace 
your MultiScribe disk with your Picture 
Manager disk and press Li1. 

A list of picture files appears in the scroll window of the Open 
dialog box. Scroll until you find a picture file named "Horse." 

• Click on "Horse" or scroll the list until "Horse" 
is selected. 

• Click on Open or press Return. 

A double high-resolution picture of a horse appears on your 
screen. In the upper left comer of the screen, just to the left of 
the horse's eye, is the picture frame. 

Now you're ready to begin working with the picture file. 

20 Chapter 2: A Quick Look at Picture Manager 
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Toggling the 
Screen Icon 

At this point, note the small rectangular box in the top right comer. 
This pictoral representation, or "icon" of the screen works as a 
"toggle" switch to allow you to alternately hide and display the 
menu bar. Hiding the menu bar allows you to see a picture in its 
entirety. Displaying the menu bar allows you to have access to the 
pull-down menus. It's important to note, however, that all the 
Picture Manager commands except About Picture Manager and 
Invert Picture have keyboard equivalents which can he used even 
when the menu bar is hidden. 

• If you're using a mouse, click once on the 
screen icon. 

• If you're using the keyboard, press the space 
bar. 

The menu bar disappears, allowing you to see and work with 
the full picture. The screen icon has changed: it now contains a 
menu bar, representing a screen with a menu bar. Using the 
screen icon now will restore the menu bar to the screen. 

• Click again on the screen icon or press the 
space bar. 

The menu bar returns to the top of the screen. 

21 Toggling the Screen Icon 



Inverting the 
Screen 

In addition to allowing you to toggle the menu bar on and off, 
Picture Manager lets you invert the screen, turning the light 
portions of your picture dark and the dark portions of your picture 
light. This command is similar to the MultiScribe Invert Screen 
command, except that pictures inverted with the Picture Manager 
Invert Picture command remain inverted when they're copied onto 
the Clipboard, pasted into MultiScribe documents, and printed 
with MultiScribe. 

Let's see how Invert Screen works. 

• Choose Invert Picture from the CJ Menu. 

The picture of the horse is inverted. 

Of course, as with Invert Screen in MultiScribe, you can 
always restore the screen to normal display -just choose 
Invert Picture again. 

• Choose Invert Picture from the CJ Menu. 

The picture is restored to normal. 

With this feature you can create both normal and inverted 
copies of the same picture. 

22 Chapter 2: A Quick Look at Picture Manager 
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Moving and 
Sizing the Picture 
Frame 

Moving the Picture 
Frame 

Now let's use the picture frame to "frame in" the part of this 
picture that you want to add to your MultiScribe text file. To 
select part of a picture to be added to a text file, you first move the 
frame to the part of the picture you want to select, then resize it to 
include the entire part of the picture you want. 

Before you begin to resize the picture frame, you should note that 
only the right and bottom sides can be used to expand the 
picture frame. The top and left sides are stationary and are used 
to reduce the size of the Picture Frame. 

• If you're using a mouse, click anywhere inside 
the picture frame, and holding down the mouse 
button, drag to the right. 

• If you 're using the keyboard, press the � key 
several times. 

The picture frame moves to the right. 

• If you're using a mouse, click anywhere inside 
the picture frame, and holding down the mouse 
button, drag down. 

• If you're using the keyboard, press the J, key 
several times. 

The picture frame moves down. 

• If you're using a mouse, click anywhere inside 
the picture frame, and holding down the mouse 
button, drag to the left. 

• If you're using the keyboard, press the f- key 
several times. 

The picture frame moves to the left. 
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The picture frame moves up. 

To shrink the picture frame, hold down both the • and ..:.. keys 
while pressing the f-- and i keys. 
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The right side of the picture frame moves to the left, decreasing 
its width. 

The picture frame expands to the right. 

The picture frame expands downward. 

• If you're using a mouse, click on the right side 
of the picture frame and, holding down the 
mouse button, drag to the right. 

• If you're using the keyboard, hold down the O 
key and press the � key . 

• If you're using the keyboard, hold down the O 
key and press the J, key. 

• If you're using a mouse, click on the right side 
of the picture frame and, holding down the 
mouse button, drag to the left. 

• If you're using the keyboard, hold down the O 
key and press the f-- key. 

• If you're using a mouse, click on the bottom of 
the picture frame and, holding down the mouse 
button, drag down . 

To resize the picture frame, you first "grab" it on the right side or 
bottom and "pull" it to the right and down to expand it, or to the 

, left and up to shrink it, until it's the appropriate size. You do this 
with either the mouse or with the · and arrow keys. 

Sizing The 
Picture Frame t 
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By using the mouse to drag the picture frame or by using the 
arrow keys, the picture frame can be moved to any part of the 
screen. 

The arrow keys seem to move the picture frame a bit slowly; 
this is because pressing an arrow key moves the picture frame 
one pixel at a time in the direction of the arrow on the key 
pressed. To move the picture frame faster, hold down the II 
key (not the · key, which, as you'll soon see, serves a 
different function) while pressing the appropriate arrow key: 
this moves the picture frame 10 pixels at a time. 
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• If you're using a mouse, click anywhere inside 
the picture frame, and holding down the mouse 
button, drag up. 

• If you're using the keyboard, press the i key 
several times. 



o File Edit 

The bottom of the picture frame moves upward, shrinking the 
frame vertically. 

If you're using the keyboard, the picture frame can be 
expanded faster if you hold down both the • and ·_": keys 
while pressing either the � or .J, key. To shrink the picture 
frame faster, hold down both the ti and j keys while pressing 
the f- and i keys. 

• If you're using a mouse, click on the bottom of 
the picture frame and, holding down the mouse 
button, drag upward. 

• If you're using the keyboard, hold down the CJ 
key and press the T key. 

• Holding down the CJ and • keys 
simultaneously, press the appropriate arrow 
keys until the picture frame is the desired 
shape and size. 

The picture frame can be expanded in any direction by using 
the corresponding arrow key. 

The flexibility of the mouse provides some capabilities not 
available to keyboard mouse users. For example, by dragging 
the lower right comer of the picture frame in either direction, 
you can change the shape of the frame diagonally - altering 
the height and width of the frame simultaneously. 

• If you're using a mouse, click and hold on the 
lower right corner of the box and 
simultaneously drag to the right and down. 

The picture frame expands both horizontally and vertically. 
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• If you're using a mouse, click and hold on the 
lower right corner of the box and 
simultaneously drag to the left and up. 

The picture frame shrinks both horizontally and vertically. 

Continue expanding and reducing the picture frame until you 
have framed in the portion of the picture you want to add to 
your Multiscribe document. If you want to use the entire 
picture, enlarge the picture frame until the picture is completely 
framed. Whatever is visible in the picture frame is what will 
appear in your text document. If your picture extends to the 
edges of the screen, however, the picture frame will not he able 
to capture the entire picture. In most cases, you'll be able to 
capture most, if not all, of a picture at once. If you need to 
capture a picture occupying an entire screen, frame the picture 
in several parts. 

""' NOTE: While mouse users have the advantage of ' 
manipulating the picture frame faster, keyboard users have 
the advantage of accuracy. For this reason, mouse users 
may prefer to use the mouse for large, quick moves and 

� the keyboard for more refined (pixel-by-pixel) movements . .1. 
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Copying the 
Picture to the 
Clipboard 

Once you're satisfied with the portion of the picture you've 
framed, you must copy it to the Clipboard before it can be 
added to your text file. Picture Manager uses the same 
Clipboard as MultiScribe, which means that, as with text, only 
one selection can be held in the Clipboard at one time. 

If you toggled off the menu bar, use the screen icon to toggle it 
on. 

• Choose Copy from the l;dit Menu or press 
cc, 

Getting Back to 
MultiScribe 

No« that you've copied your picture selection to the Clipboard. 
you're ready to add it to your Multi Scribe text document. 

• Choose Quit to MultiScribe from the File Menu 
or press - a. 
Note that Picture Manager returns to the place in your 
docu!nen_t where the ins_ertion point was located when you quit 
MulrrScribe to access Picture Manager! Everything in your 
document is just as vou left it! � . . 

I 
!�:u� �:�b1�ew�:e ��:�::� ��: :d�/b�;�w��: ; 

() File Edit Search Format Font Size Style 

The picture selection is placed in your document at the insertion 
point. Congratulations - you've just learned how to use 
Picture Manager: 

The picture looks funny. however - like somebody stretched 
it'. What happened to our horse? Well, to understand what 
happened to the horse - and what happens to every picture 
you bring into a .\1ultiScribc document - you have to know a 
little bit about how Picture Manager works. 

29 Placing the Picture into Your Document 

Position the insertion point at the place in your text where you 
would like to add the picture. 

• Choose Paste from the Edit menu or press .-:-.v. 

Placing the 
Picture into Your 
Document 

�I 

I 
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The menu bar and arrow pointer disappear from the screen 
while your picture selection is transformed in memory to an 
acceptable MultiScribe format, so don't be alarmed if no�hi!lg 
seems to be happening for a few seconds - your Apple rs Just 
"thinking" real hard. While copying, you won't_ be able to 
perform any other functions, as you have no pomter, no menu 
bar, and the keyboard is disabled. After a short while, the 
menu bar returns and your disk drive whirs as the picture 
selection is copied to the Clipboard. When the process is 
completed, control returns to your mouse and/or keyboard. 

You've just copied the picture to the Clipboard, and you're 
ready for the final step - to add the picture to your text 
document. 

v NOTE: If a dialog box appears telling you that you have "' 
too many fonts on disk, it may be necessary to return to 
MultiScribe and select fewer fonts, using the Select New 
Fonts command, before your picture can be copied. You 
can also delete fonts while in Picture Manager with the 
Delete Fonts command; this is a more drastic step and one 
you will only want to use if you're running out of room 
on your disk or if you don't want to quit Picture Manager 
and don't mind removing some fonts from your disk. 
Refer to "Select New Fonts" in the MultiScribe User's 

� Manual or "Delete Fonts" in Chapter 4 of this manual. ,1, 
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Picture Manager takes a picture or a selected part of a picture and 
converts it into a font. This is why you have to make sure you 
have less than 16 fonts on your MultiScribe disk (or in the set of 
fonts currently selected with the Select New Fonts command) 
when you use Picture Manager: MultiScribe can only use 16 fonts 
at one time and there has to be room for the new font you create. 
This new font is called a picture font, and when you copy a picture 
selection to the Clipboard and return to MultiScribe, this font is 
named, numbered, and added to the MultiScribe Font Menu. 

How Picture 
Manager Works 

DOD 
r;JDD 

The selection is then saved as a chunk of text containing only 
those characters in the ASCII character set necessary for 
forming the picture when displayed. Picture font characters 
start 'with the space character (ASCII 32) and continue in order 
through the ASCII code sequence until the last necessary 
character is reached. If you were to select the picture characters 
(and they can be selected, like any other set of characters) and 
change them to a different font, they would consist of the 
characters including and following the space character-!,", 
#, etc. 

If you're familiar with the MulttScribe FontEditor, you can 
even use the FontEditor to edit those characters in the font 
created by the Picture Manager. This allows you to modify 
your drawings even after you've put them into your 
documents. When you look at a picture font with the 
FontEditor, you can see how it was formed and how it follows 
the ASCII sequence. You can also pull down the FontEditor 
Font Menu to see its font number, or change its font number 
with the Change Font Number command on the File Menu. 
For more on how MultiScribe fonts work, see "About 
MultiScribe Fonts" in Chapter 5 of the MultiScribe User's 
Manual. 
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Notice the last fontname on the menu - "HORSEOI .PCFT." 
This is your horse picture - converted to a font! To create a 
picture fontname, Picture Manager takes the name of the picture 
file (or the first eight characters of the name, if it's longer than 
eight characters), adds the number of times a part of that picture 
has been copied to the Clipboard ("01," in this example) to this 
name, adds a period to signal that a filename extension is about 
to follow, and then adds the filename extension "PCFT," for 
"picture font." Picture Manager also gives the new picture font 
a font number - starting at 184 and continuing to 200. 

When your picture selection is converted in memory to 
MultiScribe font format - when your Apple appears to be 
"thinking" real hard - Picture Manager is "cutting" your 
picture up into squares which become the characters in the 
picture font, starting with the upper left corner of the picture 
and continuing through the bottom right corner of the picture. 
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• Pull down the Font Menu. 
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ithout warning, the man in the tower took hold. of the rope and slid 
down to the stables where the owners were standing. The two mares 

6 File Edit Seuch Formit Font Size Style 

The picture appears to be normal now, looking like it did when 
displayed on the Picture Manager screen. If you print it, 
however, you'll want to return it to its tall state so that it will 
appear normal when printed. To change the picture back, just 
select it again and choose Tall from the Style Menu. 

When you load a picture into MultiScribe, two rulers are 
inserted into the document above and below the picture. The 
first ruler, which precedes the picture, is a copy of the first 
ruler in the document with the line spacing set to zero spacing, 
whereas the second ruler is a copy of the first ruler in the 
document, with the line spacing set to the regular single 
spacing. If you've inserted other rulers into your document 
with different settings than on the first ruler, these new rulers 
may affect formatting in the parts of the document following 
the picture. You can correct this by making the necessary 
changes to any rulers following the picture. 

33 How Picture Manager Works 

· The picture can be selected just like any other collection of 
characters. 

• choose Tall or Plain from the Style Menu. 
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But none of this explains why the horse appears to be stretched 
out vertically. The reason for this is simple - MultiScribe and 
most Graphics programs print differently for different reasons. 

Your computer monitor displays things by means of a large 
grid of tiny dots of light called pixels which can be turned on 
and off (or given specific colors, if you're using a color 
monitor). 

The high resolution of the Apple screen is either 280 pixels 
across (high resolution) or 560 pixels across (double high 
resolution) horizontally, but it's always 192 pixels vertically. 
MultiScribe uses double high resolution. This means that what 
you see on the MultiScribe screen is what you get when you 
print out, but it looks a bit different on the screen than when 
printed, because the pixels are taller than they are wide, to 
make up for the different in horizontal and vertical resolution. 
(This is why MultiScribe fonts sometimes appear to be 
elongated when on the screen but normal when. printed.) _Most 
graphics programs, on the other hand, make adjustments m the 
picture from the screen to the printed page to give you the best 
representation of the picture on both the screen and on your 
printout. 

When your picture is placed in the document, the Tall 
command on the Style Menu is selected for the picture font. To 
make the picture appear as it did when displayed as a picture, 
you can select the picture in your document and deselect the 
Tall style. 

• Select the picture in your document. 



Working with 
Pictures in 
Multi Scribe 

I Working with pictures pasted into MultiScribe documents is quite 
easy once you know a little bit about how these pictures are being 
handled by MultiScribe. Basically, there are five important things 
to keep in mind when attempting to edit or move pictures or 
surround them with text. 

O Picture Manager converts a picture to a special font 
format and writes the picture as a sequence of 
characters in this font on the Clipboard. This means 
that you can edit a picture as you would any other sequence of 
characters - by selecting the picture characters and then 
performing an edit operation. In this manner a picture can be 
deleted (with Cut or the Delete key), moved to a new location 
in the document (with the Cut command), duplicated (with 
Copy), enlarged (with the Size Menu options), styled (with the 
Style Menu options), placed in headers and footers, and even 
converted to another font. In addition, picture characters can 
be edited with FontEditor, so you can even modify a picture 
once it's in a document. 

8 When you paste a picture into a MultiScribe 
document, two rulers are placed into the document, 
one immediately preceding and one immediately 
following the picture. These rulers are duplicates of the 
first ruler in the document; for this reason, any text following a 
picture which has formatting different than that specified by the 
first ruler in the document will have its formatting changed. To 
remedy this problem, simply copy the ruler with the differ�nt 
formatting and paste this copied ruler into your text followmg 
the picture. The ruler preceding the picture has line spacing set 
to zero-spacing; this is to allow the characters in the picture font 
to form a picture without spacing between the lines of 
characters. 

@) When you paste a picture into a MultiScribe 
document, it activates the Tall style on the Style 
Menu and the picture is in Tall. For reasons discussed 
in "How Picture Manager Works" in this chapter, pictures 
appear elongated when brought into MultiScribe documents. 
You can make a picture appear "normal" by selecting it and 
toggling Tall off by choosing Tall from the Sty le Menu. You'll 
probably want to have the picture in Tall format when you print 
the document, however, because when a picture appears 
"normal" on the screen it will appear compressed when printed. 
Remember, however, that any text you place near a picture will 
default to Tall. 

O If you want to place text around a character, use a 
font with an ascent less than 22 pixels and a descent 
less than eight pixels. Most fonts will work just fine with 
pictures. Some very large fonts, however, have ascents or 
descents greater than that of a picture font and will cause the 
picture to appear split up into lines of picture pieces. If you 

. have any questions about using a particular font with a picture, 
you can check out its ascent and descent with the FontEditor. 
For more information on the ascent and descent of a font, see 
"About MultiScribe Fonts," in Chapter 5 of the MultiScribe 
User's Manual. 

0 If you want to move picture characters - to center 
it on the screen, for example - change the font 
before using the space bar because the space 
becomes a picture character and funny pieces of 
your picture will appear when you press the space 
bar. Using the Tab key inserts a regular tab, however, and is 
preferable to using the space bar anyway, because you adjust 
the placement of the picture on the screen just by moving the 
tab to a new location on the ruler's inch scale. 

With this information on how Picture Manager works and how to 
work with pictures in MultiScribe, this tutorial chapter has 
provided you with everything you need to know to place pictures 
into your documents. The next chapter, "Using Picture Manager," 
provides detailed instructions on how to perform specific tasks 
with Picture Manager, while Chapter 4, "Picture Manager 
Reference," provides a summary of all the menus and commands 
you'll encounter while using Picture Manager. 
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Introduction This chapter provides more detailed instructions for performing 
specific tasks with Picture Manager. 

The first section, "Creating Picture Files," describes some 
procedures that will help you set up your files to make full use of 
Picture Manager. 

The next five sections cover the most commonly-used Picture 
Manager tasks, such as "Opening a Picture File" and "Resizing the 
Picture Frame." 

Chapter 3 concludes with the section "Things You Should 
Know," which includes miscellaneous information about specific 
program functions not already covered in previous parts of the 
manual. 
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Creating Picture 
Files for Use with 
MultiScribe 

As You Create Your · 
Picture Flies 

There are numerous sophisticated graphics programs available for 
the Apple Ile and Ile. Rather than duplicate the capabilities of 
those programs, Picture Manager links your picture files to your 
word processing document text files. 

The limitations of your picture and graphic drawings will depend 
upon the program you use to create them. Picture Manager works 
with any ProDOS single or double high-resolution binary picture 
file. 

For specific instructions on creating a picture file, you should refer 
to the user's manual for the particular graphics program you're 
using. 

As you create a picture file using a graphics program, it may be 
more convenient to put several picture "pieces" on the same picture 
file. For example, if you use a variety of bar and pie charts to 
illustrate a document, they could be created on the same file and 
listed as "Charts." 

With Picture Manager's ability to select any portion of a picture, 
you can add an individual "piece" where it is needed, or as much 
of the picture file as Picture Manager can frame. Saving several 
small pictures in one graphics file eliminates the need to search 
through multiple files to locate a particular illustration. 

If you have sufficient space on your disk, you might find it 
convenient to save your picture files on the same disk as your 
MultiScribe text files. This allows for quick and easy access of 
your pictures while writing or editing your document. 

If you plan to create several pictures to be used with a variety of 
documents, consider setting up a separate disk to hold all of your 
picture files. Creating a "picture portfolio" of commonly-used 
graphics keeps your text document disks from filling up too 
quickly. 

39 Creating Picture Files 
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Open Picture 

I PATH: I 
u Drive 1 I Press 61 

Pleue select Drive 2 l Press 62 
Drive l, Drive 2 Path l Press 6P 
or Path. List Yol. I Press 6Y 

I Open I Press (REWRH> 
'i I Cancel I Press (ESC> 

6111 Edit 

A dialog box appears. 

The Picture Manager Open dialog box is almost identical to the 
MultiScribe Open dialog box, except that the Picture Manager 
Open dialog will only let you open picture files, while the 
MultiScribe Open dialog will only let you open word 
processing and ASCII text files. 

The Picture Manager Open dialog box contains an input bar for 
Path, a list of picture files on the current path, buttons for path 
selection (Drive I, Drive 2, Path, List Vol.), and buttons for 
Open and Cancel. 

First, let Picture Manager know where your picture files are. 
Choose the volume which contains your picture files by 
clicking on Drive I or Drive 2, or by specifying the pathname 
for the volume. 

41 Opening a Picture File 

Once you've created a picture using your graphics program, 
you're ready to add it to your text document file. 

• Choose Open Picture from the File menu, or 
press CJ J. 

Opening a 
Picture File 
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After a few seconds, the MultiScribe screen vanishes and the 
Picture Manager menu screen appears. 

If you're using more than six accessories (not including the 
FontEditor), you'll have to use the Run Accessories command 
to run Picture Manager. 

• Choose Picture Manager from the CJ menu. 

Once installed, Picture Manager is as easily accessed from 
MultiScribe as any other menu command or accessory. As you 
write documents, use Picture Manager to add creative graphics. 
Remember, pictures can be added both during the creation of a 
document or after you've completed your text. 

When you quit the Picture Manager program you'll return to the 
place in the MultiScribe document where the insertion point was 
located when you chose to access Picture Manager without 
disturbing any of your text. Nevertheless, it's still a good idea to 
save your document before using Picture Manager. 

Getting from 
MultiScribe 
to Picture 
Manager 
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Moving the Picture Frame To Move the Picture 
Frame to the Right 
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• If you're using a mouse, 
click anywhere inside the 
picture frame and, holding 
down the mouse button, 
drag to the right until the 
picture frame is in the 
desired location on the 
screen. 

• If you're using the 
keyboard, press the � key 
continuously until the 
picture frame is in the 
desired location. 

The rectangular box which appears on the left side of the 
screen just under the menu bar is the picture frame. With 
the picture frame, you can "frame in" the portion of the 
picture that you want to add to your MultiScribe text file. 

By using the mouse to drag the picture frame or by using the 
arrow keys, the picture frame can be moved to any part of 
the screen. 

43 Moving the Picture Frame 

The arrow keys seem to move the picture frame a bit slowly; 
this is because pressing an arrow key moves the picture 
frame one pixel at a time in the direction of the arrow on the 
key pressed. To move the picture frame faster, hold down 
the ti key (not the CJ key; which, as you'll soon see, serves 
a different function) while pressing the appropriate arrow 
key; this moves the picture frame IO pixels at a time. 
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A list of picture files on the current path appears in the scroll 
window. Scroll until you find the name of the picture file you 
wish to use. 

The picture you selected appears on the Picture Manager 
screen. You can now select the portion of the picture you want 
to include in your document file. 

If you have set up a separate disk as a "picture portfolio," 
switch to that disk to get the picture listing by specifying the 
drive or path on which your pictures are located. 

• Select a picture file by clicking on it, or scroll 
the list until the name of the picture file is 
selected. 

• Click Open or press Return. 



To Move the Picture 
Frame Down 

• If you're using a 
mouse, click anywhere 
inside the picture frame 
and, holding down the 
mouse button, drag down 
until the picture frame is 
in the desired location. 

• If you're using the 
keyboard, press the ! 
key continuously until the 
picture frame is in the 
desired location. 

To Move the Picture 
Frame to the Left 

• If you're using a 
mouse, click anywhere 
inside the picture frame 
and, holding down the 
mouse button, drag to the 
left until the picture frame 
is in the desired location. 

• If you're using the 
keyboard, press the � 
key continuously until the 
picture frame is in the 
desired location. 

To Move the Picture 
Frame Up 

• If you 're using a 
mouse, click anywhere 
inside the picture frame 
and, holding down the 
mouse button, drag up 
until the picture frame is 
in the desired location. 

• If youre using the 
· keyboard, press the T 
key continuously, until 
the picture frame is in the 
desired location. 
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Resizing the Picture Frame 

The rectangular box which appears on the left side of the 
screen just under the menu bar is the picture frame. With 
the picture frame, you can "frame in" the portion of the 
picture that you want to add to your MultiScribe text file. 

Before you begin to resize the picture frame, please note that 
only the right and bottom sides can be used to expand the 
picture frame. The top and left sides remain stationary. 

MultiScribe limits the size of a picture in a document file to 
about 2/3 the size of the screen. When creating new pictures 
to be used in your text documents, you should keep this 
limitation in mind. For this reason, if your picture extends to 
the edges of the screen, the frame will not cover the entire 
picture even when fully extended. 

45 Resizing the Picture Frame 

To Increase the Width of 
the Picture Frame 

• If you're using a mouse, 
click and hold on the right 
side of the frame and drag 
to the right until the frame 
is the desired width. 

• If you're using the 
keyboard, hold down the 
CJ key and press the � 
key continuously, until the 
frame is the desired width. 

The picture frame expands 
horizontally. If you're using 
the keyboard, you can 
increase the width of the 
frame faster by holding down 
both the CJ and 9 keys while 
pressing the � key. 
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To Increase the Height of 
the Picture Frame 

• If you're using a 
mouse, click and hold on 
the bottom side of the 
frame and drag down 
until the frame is the 
desired length or height. 

• If you're using the 
keyboard, hold down the 
o key and press the J, 
key continuously, until 
the frame is the desired 
length or height. 

The picture frame expands 
vertically. If you're using 
the keyboard, you can 
increase the height of the 
frame faster by holding 
down both the O and 9 
keys while pressing the J, 
key. 

To Expand the Width and 
Height of the Picture 
Frame Simultaneously 

• If you're using a 
mouse, click and hold on 
the bottom right corner of 
the frame and 
simultaneously drag 
down and to the right 
until the frame is the 
desired width and height. 

The picture frame expands 
diagonally. Note that this 
can only be done if you're 
using a mouse. 

To Shrink the Picture 
Frame Horizontally 

• If you're using a 
mouse, click and hold on 
the right edge of the 
picture frame and drag to 
the left until the picture 
frame is the desired 
width. 

• If you're using the 
keyboard, hold down the 
o key and press the � 
key continuously until the 
picture frame is the 
desired width. 

The picture frame shrinks 
horizontally. If you're using 
the keyboard, you can 
decrease the width of the 
frame faster by holding 
down both the O and • 
keys while pressing the � 
key. 
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To Shrink the Picture 
Frame Vertically 

• If you're using a 
mouse, click and hold on 
the bottom side of the 
frame and drag up until 
the frame is the desired 
length or height. 

• If you're using the 
keyboard, hold down the 
o key and press the i 
key continuously, until 
the frame is· the desired . 
length or height. 

The picture frame shrinks 
vertically. If you're using 
the keyboard, you can 
decrease the height of the 
frame faster by holding 
down both the O and • 
keys while pressing the i 
key. 

To Decrese the Width 
and Height of the Picture 
Frame Simultaneously 

• If you're using a 
mouse, click and hold on 
the bottom right corner of 
the frame and 
simultaneously drag up 
and to the left until the 
frame is the desired 
width and height. 

The picture shrinks 
diagonally. Note that this 
can only be done if you're 
using a mouse. 
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If you have copied a selection from one of the picture files 
provided on the program disk, one of the fonts on the Font 
Menu will appear as, "GRAPHICS.01.PCFT" (where 
"GRAPHICS" is the name of the picture file the selection was 
copied from). With this special format, picture fonts are easily 
distinguished from regular MultiScribe fonts. 

The "GRAPHICS" prefix is taken from the picture file name. 
For example, if you have a picture of cats, then "CATS" would 
be a logical name for your picture file. Consequently, if you 
used Picture Manager to copy this file, "CATS" would appear 
as the prefix of your picture font. 

The digits ".0 l" in this example are assigned by the program 
and designate the first picture font for that picture file. 
Subsequent picture fonts for the same picture file are given the 
digits ".02", ".03", etc. - designations to allow you to 
distinguish between portions of the same picture. Picture fonts 
created for other picture files will likewise be numbered starting 
with ".01 ". 

The ".PCFT" suffix stands for "picture font" and is 
automatically added to all MultiScribe picture fonts. This 
filename extension makes picture fonts easy to distinguish from 
regular MultiScribe fonts on the Font Menu. 

Picture fonts, like other fonts, actually translate a keystroke 
into a formatted character in your document. For this reason, 
you may notice that if your picture is inserted at the end of a 
document, the picture font remains in use until you choose 
another font, such as a text font. This will not occur when a 
picture is inserted between two sections of existing text. 

49 More about Picture Manager 

This section explains more about various functions of the Picture 
Manager program. 

After Picture Manager has been used to copy a picture file, note 
that a font has been added to the MultiScribe Font Menu. A 
picture is created with a series of "picture characters" which make 
up a picture font, which is placed on your MultiScribe disk when 
you create it with the Copy command. In order to print the 
picture, this font MUST be listed on the Font Menu. 

• Pull down the Font Menu. 

More about 
Picture Manager 
About Mul_tiScribe 
Picture Fonts 
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Because the Clipboard can only hold one picture at a time, 
paste the picture currently on the Clipboard into your document 
before adding other pictures. 

The picture is placed in your word processing document at the 
insertion point. 

"Working With Your Picture," in the next section of this 
chapter, gives a detailed explanation of how to move a picture 
once it has been added to the MultiScribe document. 
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The Picture Manager's Copy command is similiar to the Copy 
command in MultiScribe because it copies the selected picture 
portion to the Clipboard. Because Picture Manager uses the same 
Clipboard as MultiScribe, only one selection can be held in the 
Clipboard at a time. 

While similiar to the MultiScribe Copy command, the Picture 
Manager Copy command actually performs two different tasks. 
First, it converts the selected portion of the picture to a 
MultiScribe font, which is named after the filename associated 
with the picture. Second , it writes this "picture text" onto the 
MultiScribe Clipboard and places the newly-created picture font on 
the MultiScribe Font menu. 

A detailed explanation of picture fonts is given later in this chapter, 
in the section "Other Things You Should Know About Picture ii!_ 
Manager." 

• To use the Copy command, first frame in the portion of 
the picture you want to add to your MultiScribe 
document. 

• Choose Copy from the Edit Menu or press oc. 

• Quit the Picture Manager by choosing Quit to 
MultiScribe from the File Menu or pressing oa. 

• Position the insertion point at the place in your text 
where you would like to add your picture. 

• Choose Paste from the Edit Menu or press ov. 

Copying and 
Pasting Your 
Picture 



Hidden Rulers 

Working with Your 
Picture 

Because MultiScribe can use a maximum of 16 fonts, up to 15 
picture fonts can be created and printed at one time by selecting 
only one font in your font set with the Select New Fonts 
command or by deleting all of the text fonts except the one used 
to create text in your document. For more information on 
selecting fonts for the current path, see "Select New Fonts" in 
Chapter 4 of the MultiScribe User's Manual. For a detailed 
explanation of how to remove fonts from a disk, see "Delete 
Fonts," in Chapter 4. 

Picture Manager adds two rulers to the picture selection when it is 
pasted into a MultiScribe document. This allows for flexibility in 
formatting the picture differently than the text. 

If you have Show Rulers chosen when you access the Picture 
Manager program, these rulers will appear after the picture has 
been pasted into your text document. If you have the rulers 
hidden, they must be "toggled on" through the MultiScribe menu 
if you want to change the format. 

• Choose Show Rulers from the Format menu, or press 
OM. 

Because these "hidden" rulers are a part of your picture, it's 
important that they aren't accidently deleted or "left behind" 
when moving or copying your picture to another part of the text 
document. 

When Picture Manager copies the picture to a MultiScribe 
document, it automatically places the picture on the left side of the 
screen one line below where you placed the insertion point. 

If you'd like to center, justify, or move the picture to the right side 
of your text document, you can do this in two ways: 

O Select the insertion point in front of each line of the picture and 
move the picture to the right by pressing the Tab key. Don't 
use the space bar to move the picture since the program 
equates a space to another character in the picture. · 
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@ Center or Justify the picture within your document margins 
using the settings on the "hidden rulers" described above. 

!"' NOTE: As with MultiScribe text, the text formatting 
affected by ruler settings appears on the printed document 

� only and not on the screen. 

If you'd like to add another copy of the same picture to another 
area of your document, or if you want to move the picture to 
another part of the document altogether, select the picture and use 
the Copy, Cut, and Paste commands of the MultiScribe Edit Menu 
as you would any other text. 

After a picture has been copied using Picture Manager, you'll 
notice that it appears "stretched" or elongated on your screen. 
This is the result of vertical resolution differences between your 

_computer and dot matrix printers. When printed, your picture will 
appear normal because the printer contains twice as many pixels 
per vertical inch as your monitor. 

If you'd like to view your picture on the screen as it will appear 
when printed: 

• Select the picture. 

• "Toggle Off" the Tall style by choosing Tall or Plain from 
the Style Menu. 

After you are through working with the picture, return it to the 
elongated form by toggling on the Tall selection from the Size 
menu. Remember, Tall selection must be selected (indicated by 
a " --./ " to the left of Tall on the Style Menu) for your picture to 
be printed correctly. 
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Using the Mouse with the Picture Frame 
The flexibility of the mouse provides some capabilities not 
available to keyboard users. For example, clicking and holding on 
the lower right comer of the frame while dragging toward or away 
from the center of the screen will expand or reduce the Picture 
Frame diagonally - both horizontally and vertically at the same 
time. 

The larger, rectangular box on the left side of the screen just under 
the menu bar is the picture frame. With the picture frame, you 
can "frame in" all or any portion of the picture that you want to 
add to your MultiScribe text file. 

Moving the Picture Frame 
To move the picture frame, use the mouse to click anywhere inside 
the frame and drag it to the desired location on the screen, or use 
the keyboard arrow keys. Either method will move the picture 
frame to any part of the screen. If you're using the keyboard, the 
picture frame can be moved in larger increments if you use the • 
and the arrow keys together. 

55 The Picture Manager Screen 

Reducing the Picture Frame 
The top and left sides of the picture frame are stationary, 
allowing you to reduce the size of the picture frame. Use the 

· mouse to drag from the right or bottom of the frame. With the 
keyboard, hold down the O while pressing the f-- or i keys. The 
picture frame will shrink faster if both O and • keys are held 
down' while you press the approprite arrow keys. 

Expanding the Picture Frame 
For expanding the picture frame, remember that only the right 
and bottom sides will expand the frame by "pulling" these sides 
out. To expand the picture frame, use a mouse to "pull" from the 

I bottom or right sides, or use the keyboard by pressing O and the 
--t or -1.. keys. The picture frame will expand either to the right or 
downward. The picture frame will expand faster if both O and • 
keys are held down while pressing the approprite arrow keys. 

The Picture Frame 
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• the menu bar 
• the screen icon 
• the picture frame 
• the work area 

There are four components of the Picture Manager screen: 

Like MultiScribe, Picture Manager features "pull-down" menus. 
The menu bar contains the titles of the menus from which you'll 
choose commands. 

The small rectangular box in the top right comer is a pictoral 
representation, or "icon," of the screen. The screen icon works as 
a '.'toggle" switch to h�de and display the menu bar. By clicking 
with a mouse or pressmg the space bar, the menu bar disappears,. 
allowing you to see and work on the entire screen. When you 
switch the menu bar off, the screen icon contains a menu bar, 
indicating that the menu bar is now hidden and can be displayed 
again by toggling the screen icon. Toggle again by clicking the 
screen icon with the mouse or pressing the space bar to return to 
the screen with the menu bar displayed. 

The Picture 
Manager Screen 

The Menu Bar 

The Screen Icon 



The • Menu contains miscellaneous commands not found on 
other menus. 

This command displays information about the Picture Manager 
program. When you choose About Picture Manager, a dialog box 
appears, telling you Picture Manager copyright and authorship 
information. 

D 

D 
II File Edit 

The Menu 

About Picture 
Manager 

The size of the Picture Manager work area is limited only by your 
screen. When a picture is opened, it appears within the work area 
so that you can select all or any portion of it. Toggling the menu 
bar off by clicking the screen icon or pressing the space bar 
enlarages the work area to show the top portion of your picture. 

Picture Manager's Work Area is not the same as a graphics 
program's work area since you cannot make changes to the 
picture. If you wish to change your picture, you will need to do 
this through the original graphics program before adding it to your 
document with Picture Manager. 

The Work Area 
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Picture lllniger Y 1.1 
by E.B. Loewenstein Cc) 1986 Stylelllre, Inc. 

r::::::or:::) Press <RETURN> 

When you've finished reading the dialog box, click the "OK" 
button or press Return. 

The Invert Picture command changes any positive or light parts of 
a picture on the screen into reverse or dark parts and vice versa 
(i.e., light areas will become dark and dark areas will become 
light). As with the MultiScribe Invert Screen command, the Invert 
Picture command is a "toggle on/off' command selected with 
either the mouse or the keyboard mouse. 

Unlike MultiScribe, however, using this option reverses the 
printed version as well as the screen. This allows you to reverse 
pictures to positive or negative as needed. Once the picture is 
added to your Multiscribe text document, it will remain normal or 
inverse as you have specified and will be printed accordingly. 

57 The O Menu 
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The buttons for selecting path - the Drive 1, Drive 2, Path, and 
List Vol. buttons - allow you to specify the path from which you 
want to open pictures. If you haven't specified a pathname since 
starting up MultiScribe - if you haven't performed any Save or 
Open operations in MultiScribe or opened a picture in Picture 
Manager - the Open button will be dimmed and the list box will 
contain a message asking you to select a drive or specify a path 
name. Before you select a picture to open you'll want to be sure 
that you've chosen the correct path from which to open your 
picture files. 

A path is either a volume - a disk drive like drive I or drive 2 or 
a hard disk - or a volume and subdirectories. If you want to 
open a picture file on the disk in drive I or drive 2, just click on 
the Drive I or Drive 2 button or press CJ I or 02. If you want to 
open a picture file on a hard disk or on a subdirectory of a volume 
and you know the pathname for the path where the picture file is 
located, click on the PA TH input bar or Path button, or press OP, 
and enter the pathname from which you want to read the picture 
file. You can enter a pathname with a length of up to 40 
characters. 

When you've chosen a path, all the directories and picture files on 
that path are displayed in the list box. Directories are differentiated 
from other types of files by being preceded by a slash. 

59 The File Menu 

Open the volume or directory by double-clicking on the selected 
volume or directory name or by clicking on the Open button if 
you're using a mouse, or by pressing the Return key if you're 
using keyboard controls. The picture files on that volume or 
directory are displayed in the list box. 

If you want to open a document but can't remember the path on 
which it's stored, click on List Vol. or press CJV to list all online 
volumes in the scroll window. Volumes are distinguished from 
document files by being preceded by a slash ("/") and followed by 
the volume's slot and drive number. Directories are also preceded 
by a slash but are not followed by slot and drive numbers. To list 
all the picture files on a volume or directory, select the volume or 
directory by scrolling the scroll window until the desired directory 
name is highlighted. 
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1111111 Press 62 
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Open Picture 

DRAGON 
PAINT 
BLUEJAY 
SPHERES 

Open Press <RETURN> 
+ Cancel Press (ESC> 

.._ ......& .... 

I PATH= IPIC.IICRI 

6DII Edit 

The Picture Manager Open Picture dialog box is almost identical to 
the MultiScribe Open dialog box, except that the Open Picture 
dialog box will only let you open picture files, while the 
MultiScribe Open dialog box will only let you open word 
processing and ASCII text files. 

The Open Picture dialog box contains an input bar for Path, a list 
of picture files on the current path, buttons for path selection 
(Drive 1, Drive 2, Path, List Vol.), and buttons for Open. and 
Cancel. 

To use a picture in your MultiScribe document, read the picture 
from disk with the Open Picture command from the File menu. 
When you choose Open Picture from the File Menu, a dialog box 
appears. 

The File Menu contains commands for managing picture and font 
files on your disk, and to allow you to return to MultiScribe. 

he File Menu 

Open Picture 



To open a document: 

• If you're using a mouse, double-click on the picture you 
want to open 

OR 

6DIII Edit O 

Delete Font 

I PATH: tHIJL TISCRIBEt 

HEtl!HG!IAY 

The· Picture Manager Delete Font dialog box is similar to the Open 
Picture dialog box, except that while the Open Picture dialog box 
will let you open picture files, the Delete Font dialog box will let 
you select fonts for deletion to free up space on your disk. 

The Delete Font dialog box contains an input bar for Path, a list of 
the currently selected set of fonts, buttons for path selection (Drive 
I, Drive 2, Path, List Vol.), and buttons for Delete and Cancel. 

As with the Open command, the buttons for selecting path - the 
Drive 1, Drive 2, Path, and List Vol. buttons - allow you to 
specify the path from which you want to open pictures. If you 
haven't specified a pathname since starting up MultiScribe - if 
you haven't performed any Save or Open operations in 
MultiScribe or opened a picture in Picture Manager - the Delete 
button will be dimmed and the list box will contain a message 
asking you to select a drive or specify a path name. Before you 
select a font to delete you'll want to be sure that you've chosen the 
appropriate path. 

Select the font you want to delete by clicking the fontname in the 
list or scrolling the list until the fontname is highlighted; then click 
on Delete or press Return. A second dialog box appears, asking 
you to verify whether you want to continue with the deletion of the 
font you selected or to cancel the selection. 
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first select the picture you want to open by clicking on the 
picture filename or by �cro\ling the docuf!lent list until the 
picture name appears highlighted; then click on the Open 
button. 

While copying a picture to the Clip board, �icture_ M�n�ger 
automatically creates a picture �ont cons1�tmg of m?1v1dual . 
characters which make up the picture. This translation sequence is 
described in more detail in the section on Edit Menu commands 
below. 

The fonts created by Picture Manager are added to the MultiScribe 
Font Menu regardless of whether the picture you copied is used 
once, repeatedly, or not at all. _Because of �pace limitations, 
MultiScribe has a 16-font maximum capacity. If several pictures 
are used within a document, the number of fonts may reach 16 or 
the disk may become full, necessitating th� removal of one o_r 
more fonts before new pictures can be copied and used. While the 
Delete Fonts command lets you remove fonts, it is an extreme 
measure and should only be used when your disk is full or you 
have fonts you wish to remove; otherwise, use the Select New 
Fonts command on the MultiScribe File Menu to choose a smaller 
set of fonts. 

A dialog box appears when Delete Font is chosen from the File 
Menu. 

• If you're using keyboard controls, scroll the pi':ture list 
until the name of the picture you want to open is / 
highlighted. Open the picture by pressing Return. 

The picture you selected will be read from disk into memory and 
displayed in the work area on the Picture Manager screen. 

Delete Font 



The Quit to MultiScribe command quits Picture Manager and 
returns to the place in your MultiScribe document where the 
insertion point was last located before you chose Picture Manager 
from the cj Menu. Choose the Quit to MultiScribe command from 
the File Menu when you're ready to paste your picture into a text 
document. 

, Click OK or press Return if you want to continue; click Cancel or 
press Esc if you want to cancel the Delete Font operation and 
return to the picture. If you click OK or press Return, the selected 
font is deleted and you return to the Delete Font dialog box, so that 
you can delete another font, if you want. To quit from this dialog 
box and return to the Picture Manager work area, click on Cancel 
or press Esc. 

Detailed explanations of picture fonts are given in Chapter I in 
"How Picture Manager Works," and in Chapter 3, "Other Things 
You Should Know About Picture Manager." 

To copy a picture selection, first frame in the portion of the picture 
you want to _add to your MultiScribe document, then choose Copy 
from the Edit Menu or press de. The menu bar will disappear 
from the screen for afew seconds while the picture selection is 
c�mverted i1_1 your Apple's memory to a picture font. When this 
picture to picture font conversion is complete, the menu bar 
�etuT1_1s to the scree_n, and your disk drive whirs as the picture text 
is wntten to the Clipboard, and the new picture font is name, 
numbered, and placed on the MultiScribe Font Menu. When 
Picture Manager finishes writing this information to disk, screen 
control returns to your mouse and/or keyboard. 

The Edit M_enu contains only one command- Copy, which lets 
you copy pictures to the Clipboard, from which they can be pasted 
into MultiScribe documents. 

The Picture Manager Copy command is similiar to the MultiScribe 
Copy c_om�and in that it copies selected material to the Clipboard; 
the major difference between the two commands is that the Picture 
Manager command copies a selected portion of a picture 
(con�ert�d to a picture font) to the Clipboard, whereas the 
!vf ult1Scr,1be Copy co�mand copies text and text formatting 
information to the Clipboard. Also, the Picture Manager Copy 
co?11!1and r�cords whether a picture is normal or inverse for 
prmt�ng .. Picture Manager uses the same Clipboard as 
MultrScribe, so copying a picture selection will replace any text 
you have on the Clipboard. · 

Also unlike the Multiscribe Copy, the Copy command in Picture 
Manager performs two different tasks. First, it converts the 
sele�ted :portion of the picture to a sequence of characters in a 

· spec1_al p�cture !Ont. Second, it writes this "picture text" onto the 
�ultI�cnbe Clipboard, names the newly-created picture font, 
gives it a font number, and places it on the MultiScribe Font 
Menu. 

The Edit Menu 
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Delete Font 

The selected font will be 
pemnently deleted. Continue? 

I OK • I Press <RETURN> I Cancel l Press (ESC> 

NJLTOH I List Yol, l Press 6Y 
DANTE 
ASIMOV 11tj§jM Press (RETURN) 
CHAUCER - I Cancel l Press <ESC) + 

6IDUI Edit 

Quit to MultiScribe 
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Keyboard 
Equivalents to 
Picture Manager 
Commands C tl········ 

. 
:: J . 

and j 
_),g;g;I;;I;;J,. 

. :::::::::::::::::::::. 

Cc········ 
. :D . 

and 
\_,;;;;gggg;g;J,. 

.:::::::::::::::::::::. 

Open Picture 
Reads a picture font from disk 
and displays it in the Picture 
Manager work area. 

Delete Font 
Displays a list of the current set 
of selected fonts and allows you 
to delete fonts from this set to 
free disk space or to make room 
for a picture font. 

·� I 
• Moving the I Picture Frame i with the Keyboard CJ ..... 

. . 

c t 
. 

Moves the picture 
frame to the right 
one pixel. 

Moves the picture 
frame up one pixel. 

c 
. 

. 

c ... 
. 

Moves the picture 
frame to the left 
one pixel. 

Moves the picture 
frame down one 
pixel. 
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Moves the picture frame to the 
right ten pixels. 

Moves the picture frame to the 
left ten pixels. 

Moves the picture frame up 
ten pixels. 

Moves the picture frame down 
ten pixels. 
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Copy 
Converts a picture selection to � !I 
a sequence of picture font 
characters and writes this picture � !I 
text to the Clipboard, from 
which it can be pasted into a !I 
MultiScribe document. 

� !I 
� !I 
� !I 

!I 
� 

Quit to MultiScribe 
Quits the Picture Manager 
application accessory program 
and returns to the place in your 
MultiScribe document where the 
insertion point was located 
when you chose to access 
Picture Manager. 

DC········ 
. (C 

and \==================· 
. .:::::::::::::::::::::. 



Sizing the Picture 
Frame with the 
Keyboard 

Expands the picture frame to the 
right, increasing its width by 
one pixel. 

Expands the 
picture frame 
to the right, 
increasing its 
width by ten 
pixels. 

Moves the right edge of the 
picture frame to the left, 
decreasing its width by one 
pixel. 

Moves the 
right edge of 
the picture 
frame to the 
left, decreasing 
its width by ten 
pixels. 

Moves the 
bottom edge of 
the picture 
frame upward, 
decreasing its 
height by ten 
pixels. 

Moves the 
bottom edge of 
the picture 
frame 
downward, 
increasing its 
height by ten 
pixels. 
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Moves the bottom edge of the 
picture frame downward, 
increasing its height by one 
pixel. 

Moves the bottom edge of the 
picture frame upward, 
decreasing its height by one 
pixel. 
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Glossary ASCII 
Stands for American Standard Code for Information Interchange 
and is pronounced ASK-ee. This is a standardized code for 
representing letters, numbers, and punctuation characters in a 
numeric form easily understood by a computer. 

Command 
A command is any instruction you give MultiScribe or Picture 
Manager in order to perform an operation or task. 

Dialog Box 
Dialog boxused in MultiScribe and Picture Manager to obtain 
information from you or to get your approval before performing 
an action. 

Document 
A MultiScribe document is any text and formatting you create at 
one time in MultiScribe. When you save a document, it becomes a 
file on disk and has a ProDOS filename. 

Document Window 
The window through which you view and edit your word 
processing documents in MultiScribe. 

Highlight 
When something - text, a ruler, a filename - is highlighted, it 
appears in inverse video on the screen. The parts of the 
highlighted material which normally appear light will appear dark, 
and vice versa. When something is highlighted, it is usually 
selected, which means that it has been chosen as the portion of 
the document to receive the action of the next command. 

Insertion Point 
The flashing vertical bar that marks the place where text appears 
as you type or the point at which a picture copied with Picture 
Manager will appear when you choose Paste. 

Menu Bar 
Contains the titles of the pull-down menus from which commands 
can be chosen. 

Picture Frame . 
In Picture Manager, the rectangular box used to select the portion 
of the picture to be added to your text document. 
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Pixel 
Stands for 11icturc element. In your computer's graphics mode, 
the screen display consists or a grid or pixels which can he turned 
on and off to form text and graphics patterns. 

Screen Icon 
Small pictorial representation on the Picture Manager screen used 
to toggle the menu bar on and off, so that you can alternately view 
the entire screen and access commands from the pull-down 
menus. 

Operation 
An operation or task is any command being executed by 
MultiScribe or Picture Manager. 
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Index A 
About Picture Manager command 57 
accessing Picture Manager 17 -40 
American Standard Code for Information Interchange 68 
Apple II Systems Utility Disk 3, 4, 9, 11 
Apple Ile computer 3 
Apple Ile computer 3 
Apple Menu(Picture Manager) 57 
Apple ProDOS User's Manual 4, 9, 11 
ASCII 68 
ASCII character set 31 
ASCII code sequence 31 

c 
centering 

a picture 4 7, 48 
Change Font Number command 31 
Clipboard 

copying pictures to 28, 50 
command 68 
converting 

a picture into a different font 34 
converting 

a picture into a font 30-31, 34, 49, 60, 63 
Copy command(Picture Manager) 28, 50, 63 

duplicating a picture 34 
keyboard equivalent 64 

Copy II Plus 4 
copying 

a picture 
to be placed in a document 28-29, 50 
to the Clipboard 28-29, 50, 63 

creating picture files 39 
Cut command(MultiScribe) 34 

deleting a picture with 34 
moving a picture with 3'1- 

D 
decreasing 

width and height of a picture simultaneously 51 
Delete Font command 28, 48, 60-62 

dialog box 61 
keyboard command 64 
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H 
hard drive, installing Picture Manager with 11-13 
headers, placing pictures in 34 
hidden rulers 48 
hiding the menu bar 21 
high-resolution 32 
highlight 68 

G 
Glossary 68-69 

increasing height of picture frame 52 
inserting 

a picture into a MultiScribe document 28-29, 50 
text into a picture 35 

insertion point 68 
Install Accessories command 5, 7, 9-10, 12, 13 
installing 

Picture Manager 4-13 
Picture Manager Two Disks on a Single 5.25-inch Drive System 

9-11 
Picture Manager with a single 5.25-inch Drive System 4-6 
Picture Manager with a Unidisk 3.5 Drive or Hard Drive 11-13 
Picture Manager with Multiple 5.25-inch Drives 7-9 

Invert Picture command 22, 57 
inverting the screen 22 

!I J 

!I justifying a picture 4 7, 48 

!I K 
keyboard equivalents 21, 64 

!I L 
� List Volume button 59 

!! M 
menu bar 18,54,68 

� displaying 21 
hiding 21 

� toggling 28,56 

-.) 
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E 
Edit Menu(Picture Manager) 63 
editing 

a picture 34 
a picture with FontEditor 34 

elongated pictures 4 7 
enlarging 

a picture 34 
height and width of picture frame 

F 
file 68 
File Menu (Picture Manager) 58-62 
filename extension (" .PCFf") 30, 49 
5.25-inch · S installing Picture Manager on a single 5.25-inch Dnve ystem 
9-11 

installing Picture Manager w�th a sin�le driye system 4-6 
installing Picture Manager with multiple dnves 7-9 

Font Menu 30, 49 
font number 31 
FontEditor (MultiScribe) 31, 34 

editing a picture with 34 
fonts, picture 30-31, 34, 49 
fonts, pictures converted into 30-31, 34, 49 
footers placing pictures in 34 
Format Menu 48 

Delete key 
deleting a picture with 34 

deleting a picture 34 
deleting fonts 28, 48, 60-62 
dialog box 68 
directories 59 
displaying 

the menu bar 21 
document 68 
document window 68 
dot matrix printer 3 
double high-resolution 32 
dual-drive system 9 
duplicating 

a picture 34 



moving 
picture files into MultiScribe documents 28-29, 50 
pictures within a document 34, 35 
the picture frame 23-24, 43-44, 55, 65 
with the keyboard 65 

MultiScribe 
quitting to 29, 62 

MultiScribe User's Manual 4, 17, 28, 31 

0 
Open Picture command 19, 41-42, 58-60 

dialog box 19, 41 
keyboard equivalent 64 

opening a picture file 19-20, 41-42, 58-60 

p 
Paste command 29, 50 
path 59 
picture element See pixel 
picture files 

creating 39 
opening 19-20, 41-42 

picture font characters 31, 49 
picture fonts 30-31, 34, 48, 49 

maximum number 48 
picture frame 18, 43, 45, 54, 55 

definition 69 
expanding 55 
moving 23-24, 43-44, 55 
moving with the keyboard 65 

picture frame 
reducing 55 
resizing 25-27, 45-46, 66-67 
resizing with keyboard 66-67 
using the mouse with 55 

Picture Manager 
accessing 17, 40 
getting around in 18, 40 
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pictures 
centering 4 7, 48 
converting to a different font 34 
converting to fonts 30-31, 34, 49, 60, 63 
copying 28-29, 50, 63 
creating 39 
duplicating 34 
enlarging 34 
inserting into MultiScribe documents 28-29, 50 
inserting text into 35 
inverting 22, 57 
justifying 4 7, 48 
moving into a MultiScribe document 28-29, 50 
moving the frame 23-24, 43-44, 55 
moving within a document 34, 35 
opening 19-20, 41-42, 58-60 
placed in headers and footers 34 
placing in headers and footers 34 
resizing the frame 26-27, 45-46, 66-67 

.selecting 32-33, 34 
shrinking 51-52 
viewing them as they will look in printed document 33, 35, 

pixels 32, 69 
placing text around a picture 35 
Plain command 33 
ProDOS single or double high-resolution binary picture file 39 
ProDOS Utilities 3 

Q 
Quit to MultiScribe command 29, 50, 62 

keyboard equivalent 64 

R 
reducing the picture frame 55 
resizing the picture frame 26-27, 45-46 

with the keyboard 66-67 
returning to MultiScribe 29, 62 
rulers 

that accompany a picture inserted in a document 33, 34, 48 
Run Accessories command 6, 9, 11, 13, 40 
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s 
screen icon 18, 21, 54, 69 

toggling 21, 54 
Select New Fonts command 28, 30, 48, 60 
selected 68 
selecting the picture 32-33, 34 
Show Rulers command 48 
shrinking 

the picture frame horizontally 52 
the picture frame vertically 51 

single-drive system 9 
Size Menu 34 
Style Menu 32, 33, 35, 47 

T 
Tab key 48 

center, justify, or move picture 48 
Tall command 32, 33, 35, 47 
text 

placing around a picture 36 
toggling 

rulers 48 
Tall command 47 
the menu bar 28, 56 
the screen icon 21, 28 

u 
Unidisk 3.5 11 

installing Picture Manager with 11-13 

v 
volumes 59 

w 
work area 18, 54, 69 
working with pictures in MultiScribe 34-35, 48 
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StyleWare, Inc. 
Technical Support: (713) 668-0759 

For Product Orders Only: (800) 233-4088 
(713) 668-0743 



For use with MultiScribe 2.0 

Picture Manager 

6 FD1 Edit Snrch fer.at font Siu Styli 

Without warning, the man In the tower toot bold of the rope and slid 
down to the stables wbtre the owners were staDdlllg. '!be two mares + 

Place single or double high resolution 
pictures into Multi.Scribe text with this new 
on-line accessory program for use with 
MultiScribe version 2.0. Picture Manager 
lets you bring your artisitic creations right 
into your Multi.Scribe documents - without 
leaving Multi.Scribe! Compatible with major 
graphics programs such as Dazzle Draw™ 
and MousePaint, ™ Picture Manager works 
with any 128K Apple Ile or Ile - with or 
without a mouse. 

You can choose specific portions of your 
pictures to place into your documents and 
copy up to 15 pictures per document. 
Pictures can be moved anywhere within a 
document, combined with text, or modified 
with the FontEditor - giving you the 
creative word processing edge. 
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